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NEW QUESTION 1
You have a dashboard that shows car rental statistics by city, including a field named Car Dropoff City in the view. A URL action in the dashboard uses
https://en.wikipedia.org/wiki/<Car Dropoff City> as the URL target.
When you click Salt Lake City in the view, to where will the URL action direct you?

A. https://en.wikipedia.org/wiki/<Car Dropoff City>
B. https://en.wikipedia.org/wiki/<Salt-Lake-City>
C. https://en.wikipedia.org/wiki/Salt.LakeXity
D. https://en.wikipedia.org/wiki/Salt+Lake+City+Car+Dropoff+City

Answer: D

Explanation: 
 When you click Salt Lake City in the view, the URL action will direct you to https://en.wikipedia.org/wiki/Salt+Lake+City+Car+Dropoff+City. A URL action is a
hyperlink that points to a web page or other web-based resource outside of Tableau. You can use URL actions to create an email or link to additional information
about your data. To customize links based on your data, you can automatically enter field values as parameters in URLs3 In this case, the URL action uses
https://en.wikipedia.org/wiki/<Car Dropoff City> as the URL target, where <Car Dropoff City> is a field value from the view. When you click Salt Lake City in the
view, Tableau will replace <Car Dropoff City> with Salt Lake City in the URL target. However, since spaces are not allowed in URLs, Tableau will encode them as
+ signs instead. Therefore, the final URL will be https://en.wikipedia.org/wiki/Salt+Lake+City+Car+Dropoff+City3 The other options are not correct because they do
not reflect how Tableau encodes field values in URL actions.

NEW QUESTION 2
Which of the following would you use to connect to multiple tables in a single data source at once?

A. A Blend
B. A Hierarchy
C. A Set
D. A Join

Answer: D

Explanation: 

The data that you analyze in Tableau is often made up of a collection of tables that are related by specific fields (that is, columns). Joining is a method for
combining data on based on those common fields. The result of combining data using a join is a virtual table that is typically extended horizontally by adding
columns of data.
For example, consider the following two tables originating from a single data source:

We can combine these 2 tables, simply by joining the tables on ID to answer questions like, "How much was paid in royalties for authors from a given publisher?".
By combining tables using a join, you can view and use related data from different tables in your analysis.

Reference: https://help.tableau.com/current/pro/desktop/en-us/joining_tables.htm

NEW QUESTION 3
By definition, Tableau displays measures over time as a ______

A. Packed Bubble
B. Bar
C. Stacked Bar
D. Line

Answer: D

Explanation: 
 Line charts connect individual data points in a view. They provide a simple way to visualize a sequence of values and are useful when you want to see trends over
time, or to forecast future values.
Please refer to the images below:
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Reference: https://help.tableau.com/current/pro/desktop/en-us/buildexamples_line.htm

NEW QUESTION 4
A _______ is a single zip file that contains a workbook along with any supporting local file data and background images. This format is the best way to package
your work for sharing with others who don’t have access to the original data.

A. .twbx file
B. .tbm file
C. .twb file
D. .tde file

Answer: A

Explanation: 
According to the official Tableau documentation:
Tableau packaged workbooks have the .twbx file extension. A packaged workbook is a single zip file that contains a workbook along with any supporting local file
data and background images. This format is the best way to package your work for sharing with others who don’t have access to the original data. For more
information, see Packaged Workbooks.
Reference: https://help.tableau.com/current/pro/desktop/en-us/environ_filesandfolders.htm

NEW QUESTION 5
Which three statements accurately describes the capabilities of dashboard actions? Choose three.

A. Can be set to dynamically update when a workbook opens
B. Can be set to Filter, Highlight, or Go to URL
C. Can be set to run on Hover, Select, or Menu
D. Can be set to be triggered on a data value
E. Can have multiple source and target sheets

Answer: BCE

Explanation: 
 Dashboard actions in Tableau are interactive elements that can be used to create a more dynamic experience. These actions can be set to filter data on the
dashboard, highlight specific elements, or even direct the user to a URL when interacting with a visualization. They can be triggered by user interaction such as
hover, selection, or accessing a context menu. Moreover, dashboard actions can have multiple source sheets (where the action originates) and target sheets
(where the action takes effect), allowing for a complex interactivity between different parts of the dashboard.

NEW QUESTION 6
Which of the following lets you group related dashboard items together so you can quickly position them?
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A. Layout Extensions
B. Layout Blanks
C. Layout Containers
D. Layout positioners

Answer: C

Explanation: 
Layout containers let you group related dashboard items together so you can quickly position them. As you change the size and placement of items inside a
container, other container items automatically adjust

Reference: https://help.tableau.com/current/pro/desktop/en- us/dashboards_organize_floatingandtiled.htm

NEW QUESTION 7
You clicked Sheet 1 from the data source page, and now you have opened the Tableau Desktop workspace as shown above.

What is the main thing that you do here?

A. Clean the data
B. Preview the data
C. Create visualisations to analyze your data
D. Rename the fields and change data types

Answer: C

Explanation: 
The Tableau workspace consists of menus, a toolbar, the Data pane, cards and shelves, and one or more sheets. Sheets can be worksheets, dashboards, or
stories. For details on dashboard or story workspaces, see Create a Dashboard or The Story Workspace.
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The main thing you do in the workspace is to create visualisations to analyze your data.
Renaming data fields, cleaning the data, previewing the data can all be done in the Data source window.
Reference: https://help.tableau.com/current/pro/desktop/en- us/environment_workspace.htm

NEW QUESTION 8
Which of the following is the correct way to calculate Profit Ratio in Tableau?

A. Profit / Sales
B. Sales / Profit
C. SUM(Profit) / SUM(Sales)
D. SUM(Sales)/SUM(Profit)

Answer: C

Explanation: 
THIS IS A VERY IMPORTANT QUESTION
Aggregation is an important concept to consider when creating calculated fields. A calculated field for SUM([Profit]) / SUM([Sales]) will give you a very different
answer than [Profit] / [Sales], even though both formulas are valid.
If you do not provide the aggregation within the calculated field, Tableau will calculate the equation for every record ( row ) in your analysis, then aggregate the
answers for all of the rows together when the calculated field is added to the view.
In simple terms, if specify the aggregation such as SUM, what Tableau will do is that it will first calculate the sum of the Profit column ( say x ), then calculate the
sum of the Sales column ( say y ), and then simply apply x/y ---> This is what we expect! Perfect!
BUT, if you don't specify the aggregation, it will go to every single ROW, perform Profit / Sales, and then aggregate the answers calculated for each row. This is
simply NOT what we wan't!
An example:

Reference: https://www.linkedin.com/pulse/tableau-tip-dont-make-error-ratio-calculations- bob-newstadt

NEW QUESTION 9
The default path for all supporting files, data sources, icons, logs etc is in _________

A. Documents -> Tableau Files
B. Documents -> Tableau
C. Documents -> My Tableau Repository
D. Downloads -> Tableau Support Files

Answer: C

Explanation: 
 By default, all of the above mentioned are stored in Documents -> My Tableau Repository Reference: https://help.tableau.com/current/pro/desktop/en-
us/environ_filesandfolders.htm

NEW QUESTION 10
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Tableau auto-generates ______ dimension(s) and ______ measure(s) for us

A. 1 , 4
B. 2 , 2
C. 2 , 3
D. 1 , 2

Answer: A

Explanation: 
 Tableau auto-generates :
1 Dimension - Measure Names
4 Measures - Latitude, Longitude, Number of records, Measure Values
Starting with Tableau 2020.2, every table in a data source has a Count field, in the form of NameofTable(Count). The table count field is an automatically
generated, calculated field. (THIS IS NOT PRESENT IN VERSION 2020.1 ON WHICH THE EXAM IS CURRENTLY BASED)
Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_understanddatawindow.htm

NEW QUESTION 10
Using the dataset, plot a Map showing all the countries, filtered by Market to only include LATAM. Which country in the LATAM Market has the highest shipping
delay (sum of total number of days between the order date and the ship date)?

A. Brazil
B. Peru
C. Argentina
D. Mexico

Answer: D

Explanation: 
 VERY IMPORTANT QUESTION FOR THE EXAM, PAY ATTENTION
1) To find the number of days between order date and shipping date, we will make use of a calculated field:

In the data pane, click on the dropdown arrow, and choose create calculated field.
Let's name this calculated field "ShippingDelay" (you can name it anything you want :) )
2) Use the DATEDIFF() function, and pass it the arguments as follows:

'day' depicts that we want to calculate the number of DAYS between the two dates. The first argument is 'start_date' which is the ORDER_DATE (day the order
was placed), the second argument is 'end_date', which is the SHIP_DATE (date the order was shipped). So
by subtracting as follows: SHIP_DATE - ORDER_DATE, we can find the delay in shipping. Click OK.
3) You should now have a new measure as follows:
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4) Phew! The hard part is done! Now let's filter by Market to include only LATAM:

5) Drag Country to the view, and the new calculated field 'ShippingDelay' to SIZE on the Marks Shelf as follows:
*You can also click on Show Text Labels to be sure that you're choosing the Largest value*

Clearly, Mexico has the highest Shipping Delay!

NEW QUESTION 13
Our use case states that we need to create a set showing the Bottom 10 products by Profit in each Region. Which of the following filter types should you apply on
Region?

A. Measure Filters
B. Context Filters
C. Extract Filters
D. Dimension Filters

Answer: B

Explanation: 
The beauty of context filters is that according to Tableau's Order of Operations, they are executed before Sets.
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This means that based on what Region's you've selected - Tableau will first only preserve the rows for those Regions. THEN, after this it will compute the Set , i.e ,
Bottom 10 products in each Region.
1) First let's create a set to compute the Bottom 10 Products by Profit.

2) Next, take region on the Rows Shelf followed by the Set we just created. Drag Region and the Set to the Filters Shelf as well.

3) Now, try to only visualize the data for the South Region:
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4) The problem right now is that Tableau is computing the Set first (Bottom 10 Products), and then applying the Dimension Filter - South Region and hence these
values are incorrect. Note how these aren't even 10 products, but rather just 8. To fix this, simply add Region to Context:

Upon doing this, we get the correct answer as :

References: https://help.tableau.com/current/pro/desktop/en-us/order_of_operations.htm https://help.tableau.com/current/pro/desktop/en-us/filtering_context.htm

NEW QUESTION 18
How do you identify a continuous field in Tableau?

A. It is identified by a blue pill in the visualization
B. It is identified by a green pill in a visualization
C. It is preceded by a '=#' symbol in the data window
D. It is preceded by a 'Abc' symbol in the data window

Answer: B

Explanation: 
 When you connect to a new data source, Tableau assigns each field in the data source as dimension or measure in the Data pane, depending on the type of data
the field contains. You use these fields to build views of your data.

Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_typesandroles.htm
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NEW QUESTION 20
Which one of the following is a dimension?

A. Longitude
B. Measure Names
C. Number of records
D. Latitude

Answer: B

Explanation: 
Measure Names is a dimension. Latitude, Longitude, and Number of records are all measures.

Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_understanddatawindow.htm

NEW QUESTION 22
You have the following legend.

What occurs when you click the icon to the right of Air Ticketing Cabin Type Name?

A. The filter options open.
B. The legend toggles on or off.
C. The highlighter toggles on or off.
D. The Edit Colors dialog box opens

Answer: C

Explanation: 
 When you click the icon to the right of Air Ticketing Cabin Type Name, the highlighter toggles on or off. The highlighter is a feature that allows you to highlight
marks in the view that match a specific value or condition. You can access the highlighter by clicking the icon next to a dimension or measure in the legend, filter,
or parameter. The icon looks like a light bulb with a plus sign. When you click the icon, a highlighter box will appear where you can enter or select a value to
highlight. The marks that match the value will be highlighted in the view, while the others will be dimmed. You can also use the
highlighter box to search for values, clear the highlighting, or lock the highlighting. To turn off the highlighter, you can click the icon again or close the highlighter
box. The other options are not correct descriptions of what occurs when you click the icon to the right of Air Ticketing Cabin Type Name. The filter options do not
open, because the icon is not for filtering, but for highlighting. The legend does not toggle on or off, because the icon is not for showing or hiding the legend, but for
accessing the highlighter. The Edit Colors dialog box does not open, because the icon is not for changing the colors of marks, but for highlighting them.

NEW QUESTION 24
Creating a scatter plot requires a minimum of how many measures?

A. 2
B. 4
C. 1
D. 3

Answer: A

Explanation: 
We can use scatter plots to visualize relationships between numerical variables!
In Tableau, you create a scatter plot by placing at least one measure on the Columns shelf and at least one measure on the Rows shelf (Total 2 minimum). If these
shelves contain both dimensions and measures, Tableau places the measures as the innermost fields, which means that measures are always to the right of any
dimensions that you have also placed on these shelves. The word "innermost" in this case refers to the table structure.

( Simple Scatter Plot)

(Matrix of Scatter Plots)

The Leader of IT Certification visit - https://www.certleader.com



100% Valid and Newest Version TDS-C01 Questions & Answers shared by Certleader
https://www.certleader.com/TDS-C01-dumps.html (314 Q&As)

A scatter plot can use several mark types. By default, Tableau uses the shape mark type. Depending on your data, you might want to use another mark type, such
as a circle or a square. For more information, see Change the Type of Mark in the View.
To create a scatter plot, follow the steps below:
Reference: https://help.tableau.com/current/pro/desktop/en-us/buildexamples_scatter.htm

NEW QUESTION 25
Which statement accurately describes aliases?

A. You can create an alias for a discrete measure.
B. You can create an alias for a continuous dimension.
C. When you assign an alias, the name changes in the database.
D. You can assign an alias to a field member before creating a visualization.

Answer: D

Explanation: 
 You can assign an alias to a field member before creating a visualization. An alias is an alternative name that you can assign to a value in a dimension field. You
can use aliases to rename specific values within a dimension to make them more relevant or descriptive in your view than what the original data provides. For
example, you can use aliases to shorten long names, correct spelling errors, or replace codes with meaningful labels6 You can create aliases for the members of
discrete dimensions only. They cannot be created for continuous dimensions, dates, or measures. To create an alias for a dimension member, you can right-click
the dimension in the Data pane and select Aliases, then enter a new name for each member under Value (Alias). You can also create an alias by right-clicking a
dimension member in the view and selecting Edit Alias. You can do this before or after creating a visualization6 The other options are not accurate statements
about aliases. You cannot create an alias for a discrete measure, because measures are not discrete fields. You cannot create an alias for a continuous
dimension, because aliases are only available for discrete dimensions. When you assign an alias, the name does not change in the database, only in Tableau.
Aliases are stored as part of the workbook or data source, and do not affect the original data6

NEW QUESTION 30
True or False: We get different colour pallete options if we drop a discrete field on "Color" in the marks card compared to if we drop a continous field on Color.

A. False
B. True

Answer: B

Explanation: 
 Yes! We get different color palettes. They are:
*From the official Tableau documentation*

To change the color for a value
1) Click on an item on the left, under Select Data Item.
2) Click a new color in the palette on the right. In Tableau Desktop you can hover over a swatch to identify the color.
3) Repeat for as many values that you want to change.
4) In Tableau Desktop, click OK to exit the Edit Colors dialog box. In Tableau Server or Tableau Online, simply close the dialog box.
AND
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Reference: https://help.tableau.com/current/pro/desktop/en us/viewparts_marks_markproperties_color.htm

NEW QUESTION 35
You have a scatter plot visualization.
What should you do to configure the visualization as a density map?

A. Change the mark shape of the view.
B. Change the mark type of the view.
C. Create a custom color palette.
D. Select heat maps from Show Me.

Answer: B

Explanation: 
 You should change the mark type of the view to configure the visualization as a density map. A density map is a type of mark that shows how data points are
distributed in a two-dimensional space. To change the mark type, you can use the Marks card or Show Me. Changing the mark shape, creating a custom color
palette, or selecting heat maps from Show Me will not create a density map2

NEW QUESTION 37
When creating an extract, what are three options for specifying how much data to extract? Choose three.

A. Hide all unused fields.
B. Aggregate data for visible dimensions
C. Compute Calculations Now.
D. Append Data from Files
E. Apply a filter.

Answer: ABE

Explanation: 
 When creating an extract in Tableau, there are several options to control how much data is included in the extract. These options include hiding all unused fields
to reduce the size of the extract, aggregating the data for visible dimensions to summarize it, and applying filters to extract only the data that meets certain criteria.

NEW QUESTION 42
Which of the following are valid Layout Container types when using Dashboards in Tableau?

A. Vertical Container
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B. Diagonal Container
C. Horizontal Container
D. Split Container

Answer: AC

Explanation: 
 Reference:
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https://help.tableau.com/current/pro/desktop/en-us/dashboards_organize_floatingandtiled.htm

NEW QUESTION 47
In an extract, what are three differences between a full refresh versus an incremental refresh? Choose three.

A. An incremental refresh only adds rows that are new
B. A full refresh must be configure
C. An incremental refresh is the default extract in Tableau.
D. An incremental refresh can only be run from Tableau Server.
E. A full refresh is usually very slo
F. An incremental refresh can take less time.
G. A full refresh replaces all the extracted data with the data in the underlying data source.

Answer: ADE

Explanation: 
 According to the [Tableau Desktop Specialist Exam Guide], an incremental refresh only adds rows that are new, based on a specified column and value. A full
refresh replaces all the extracted data with the data in the underlying data source. A full refresh is usually very slow, especially for large extracts. An incremental
refresh can take less time, depending on how many new rows are added. A full refresh does not need to be configured, it is the default option for extracts in
Tableau. An incremental refresh can be run from both Tableau Desktop and Tableau Server.

NEW QUESTION 51
Which of the following are correct ways to define a join in Tableau version 2020.3 and above?

A. Right-click a logical table and click on open to go to the Join/Union canvas in the physical layer and add joins or unions.
B. Double-click a physical table to go to the Join/Union canvas in the logical layer and add joins or unions.
C. Right-click a physical table and click on open to go to the Join/Union canvas in the logical layer and add joins or unions.
D. Double-click a logical table to go to the Join/Union canvas in the physical layer and add joins or unions.

Answer: AD

Explanation: 
 Remember that joins are defined in the physical layer and relationships in the logical layer.
You can still specify joins between tables in the physical layer of a data source. Double- click a logical table to go to the Join/Union canvas in the physical layer and
add joins or unions.
Every top-level, logical table contains at least one physical table. Open a logical table to view, edit, or create joins between its physical tables. Right-click a logical
table, and then click Open. Or, just double-click the table to open it.
When you create a data source, it has two layers. The top-level layer is the logical layer of
the data source. You combine data between tables in the logical layer using relationships. The next layer is the physical layer of the data source. You combine
data between tables at the physical layer using joins. For more information, see Logical and physical tables in the data model
Reference: https://help.tableau.com/current/online/en- us/datasource_relationships_learnmorepage.htm
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NEW QUESTION 55
How does Tableau know at which level to aggregate values?

A. Values are always aggregated at the level of granularity of the worksheet.
B. Tableau doesn't aggregate values, we do!
C. Values are always aggregated at the level of the Date Part
D. Aggregation is always done by using Tableau special formulas

Answer: A

Explanation: 
In Tableau, you can aggregate measures or dimensions, though it is more common to
aggregate measures. Whenever you add a measure to your view, an aggregation is applied to that measure by default. The type of aggregation applied varies
depending on the context of the view.
When you add a measure to the view, Tableau automatically aggregates its values. Sum, average, and median are common aggregations; for a complete list, see
List of Predefined Aggregations in Tableau.
The current aggregation appears as part of the measure's name in the view. For example, Sales becomes SUM(Sales). Every measure has a default aggregation
which is set by Tableau when you connect to a data source. You can view or change the default aggregation for a measure—see Set the Default Aggregation for a
Measure.
You can change the aggregation for a measure in the view from its context menu:

Reference: https://help.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm

NEW QUESTION 57
You have a visualization that uses multiple types of sorting. How can you clear all sorting of the visualization?

A. Right-click a sorted field, and then select Clear Sort.
B. From the Dashboard menu, select Clear.
C. From the Header label, select the sort icon.
D. From the Worksheet menu, select Clear, and then select Sorts.

Answer: D

Explanation: 
 To clear all sorting in a Tableau visualization, you would go to the Worksheet menu, select the "Clear" option, and then choose "Sorts." This action removes all
sorting that has been applied to the visualization, including any custom sorting or sorting based on multiple fields. This is a quick way to reset the view to its default
sorting state and is particularly useful when you have applied various sorting layers and wish to start fresh.

NEW QUESTION 62
When viewing quick table calculations, such as Percent Difference From, that use a value in the previous column, what will be the first data value in the
visualization?

A. Null
B. The current value
C. Zero(O)
D. Duplicated from the nearest column

Answer: A
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Explanation: 
 According to the Tableau Desktop Specialist Exam Guide, when using quick table calculations, such as Percent Difference From, that use a value in the previous
column, the first data value in the visualization will be null, because there is no previous value to compare with.

NEW QUESTION 63
What is the one critical difference between normal calculated fields, and the calculated fields created after Data blending?

A. No difference, calculated fields cannot be created in Blends
B. Fields used in Blends must first be aggregated
C. The calculated fields created in Blends cannot be edited once created
D. The calculated fields created in Blends cannot use more than 2 fields

Answer: B

Explanation: 
Yes, due to the nature of blends, there are some conditions as follows from the official documentation that must be kept in mind while working with blends:

In addition to handling calculations slightly differently, there are some limitations on secondary data sources. You may not be able to sort by a field from a
secondary data source, and action filters may not work as expected with blended data. For more information, see Other data blending issues.
Reference: https://help.tableau.com/current/pro/desktop/en-us/multiple_connections.htm

NEW QUESTION 67
What is the one most important thing you should do after creating a Dual-axis chart?

A. Synchronise the axis
B. Change the colours
C. Edit the labels
D. Hide the axis

Answer: A

Explanation: 
After creating a dual axis chart, make sure to synchronise their axis since they both might not be having the same y-axis.
To align the two axes in a dual axes chart to use the same scale, right-click (control-click on Mac) the secondary axis, and select Synchronize Axis. This aligns the
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scale of the secondary axis to the scale of the primary axis.
In this example, the Sales axis is the secondary axis and the Profit axis is the primary axis. If you would like to change which axis is the primary, and which axis is
the secondary, select the field on the Columns or Rows shelf that is the secondary, and drag it in front of the primary field on the shelf until you see an orange
triangle appear.
In this example, you can select the SUM(Sales) field on the Rows shelf, and drag it in front of the SUM(Profit) field. The Sales axis is now the primary and the
Profit axis is the secondary.

Reference: https://help.tableau.com/current/pro/desktop/en-us/multiple_measures.htm

NEW QUESTION 72
True or False: It is possible to change the Geographic Role of a dimension

A. True
B. False

Answer: A

Explanation: 
 A geographic role associates each value in a field with a latitude and longitude value. Assigning a geographic role based on the type of location (such as state
versus postcode) helps ensure that your data is plotted correctly on your map view. For example, you can assign the City geographic role to a field that contains a
list of city names.
To assign a geographic role to a field:
In the Data pane, click the data type icon next to the field, select Geographic Role, and then select the geographic role you want to assign to the field.

When you assign a geographic role to a field, Tableau adds two fields to the Measures area of the Data pane: Latitude (generated) and Longitude (generated).
These fields contain latitude and longitude values and are assigned the Latitude and Longitude geographic roles. If you double-click each of these fields, Tableau
adds them to the Columns and Rows shelves and creates a map view using the Tableau background map.

Reference: https://help.tableau.com/current/pro/desktop/en-us/maps_geographicroles.htm

NEW QUESTION 76
Which of the following is NOT a new feature introduced in Tableau 2020.1?

A. Dynamic Paramaters
B. Viz Animations
C. Buffer Calculations
D. Set Control

Answer: D

Explanation: 
Your Tableau Desktop Specialist exam will be based on the 2020.1 version.
Set controls are a new feature introduced in the 2020.2 version, and hence is the correct answer - it is not a part of 2020.1
For the 2020.1 version the new features were:
1) Viz animations:
Viz animations help you see and understand your changing data. It’s easy to track the logical steps behind data’s evolution and tell powerful data stories. Sorting,
filtering, adding fields, and other actions will now smoothly animate your visualizations. Choose whether to turn Viz Animations on or off, and decide how you’d
best like to apply animations to your new workbooks.
2) Dynamic Parameters:
Say goodbye to republishing workbooks with parameters every time the underlying data changes. Set your parameter once, and Tableau will automatically update
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the parameter’s list of values every time someone opens the workbook.
3) Buffer Calculations:

Buffer calculations allow you to visualize the distance around point locations. Give Tableau three parameters—location, distance, and a unit of measure—and a
buffer, or boundary is instantly created. Answering complex spatial questions becomes easier than ever before—visualize what properties are within 200 meters of
a proposed transit site, or how many competitors’ stores are within 1 mile of their store, and more.

NEW QUESTION 77
What does the following marker/icon do in Tableau?

A. Format the Legends
B. Edit the Colors
C. Toggle the highlighting on/off.
D. Highlight the largest value

Answer: C

Explanation: 
 Top of Form
The correct answer is Toggle the highlighting ON/OFF. If selected, whichever value you choose from this legend will be highlighted in the view. However, if it is
deselected, then even if you choose a value in the Legend, it will NOT be highlighted.
See below:
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NEW QUESTION 79
Using the atheletes table:
i) Create a sheet with a crosstab showing the Average weight for each sport (Sheet 1)
ii) Create a sheet with a Map showing the Total number of gold medals per Country. Use size as a Mark. (Sheet 2)
Now, Create a Dashboard containing both these sheets, and Use Sheet 2 as a Filter for Sheet 1. What was the average weight for Badminton in Russia?
(Ignore any nulls / unknowns)

A. 76.25
B. 65.67
C. 68.77
D. 4.87

Answer: A

Explanation: 
 Pretty common question on the Tableau Desktop Specialist exam.
1) First, lets create Sheet 1. For this, drag sport to the Row shelf, and Weight to the Text mark in the Marks shelf. Change its aggregation to Average:

2) Now, for sheet 2 - Drag nationality to the view, and gold to the size mark in the Marks shelf.
NOTE: Depending on your version of Tableau , you may need to assign a Geographical role to the nationality column first as follows:
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3) Now, let's create a dashboard, and use both these sheets in it:

4) Now, for the most Important step, use SHEET 2 AS A FILTER FOR SHEET 1 as follows:
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Now simply click on Russia in Sheet 2, and Sheet 1 will automatically update as follows:

NEW QUESTION 84
What is the following icon in the Data pane used to do? Larger image

A. View Data
B. Clean Data
C. Extract Data
D. Sort Data

Answer: A

Explanation: 
View Data allows you to inspect your data in a spreadsheet-like layout. You can view data either for the data source as a whole, or to see the underlying data for
an individual mark or a group of marks. In a worksheet, the rows that you see in the View Data window are always scoped to the current selection or the current
view.
The View Data window displays as much of the data as possible by default, up to 10,000 rows. Field names are shown as column headers and can be dragged
and dropped to change their display order. Click a column header to sort the values in that column.
From the official website:
Reference: https://help.tableau.com/current/pro/desktop/en-us/inspectdata_viewdata.htm

NEW QUESTION 88
True or False: LEFT JOIN returns all rows from the left table, with the matching rows in the right table

A. True
B. False

Answer: A

Explanation: 
 This is true, indeed!
The LEFT JOIN keyword returns all records from the left table (table1), and the matched records from the right table (table2). The result is NULL from the right
side, if there is no match.
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Reference: https://www.w3schools.com/sql/sql_join_left.asp

NEW QUESTION 89
True or False: Sets can be created on Measures

A. True
B. False

Answer: B

Explanation: 
 Sets are custom fields that are created within Tableau Desktop based on dimensions from your data source. They are subsets of your data, which can be created
manually or computed. Either dimensions or measures can be used to determine what is included or excluded from a set using conditional logic, but to CREATE a
set we use dimensions.

Reference : https://interworks.com/blog/rcurtis/2016/10/26/tableau-deep-dive-sets- introduction-sets/
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NEW QUESTION 92
A ______ action is a hyperlink that points to a web page, file, or other web-based resource outside of Tableau.

A. Go to Hyperlink
B. Go to Web page
C. Go to URL
D. Go to Sheet

Answer: C

Explanation: 
 Tricky options! Go to hyperlink and Go to Web page are not valid Actions in Tableau.

A URL action is a hyperlink that points to a web page, file, or other web-based resource outside of Tableau. You can use URL actions to create an email or link to
additional information about your data. To customize links based on your data, you can automatically enter field values as parameters in URLs.
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Reference: https://help.tableau.com/current/pro/desktop/en-us/actions_url.htm

NEW QUESTION 93
You are creating a combined axis chart.
Where should you drag the second measure after dragging the first measure to the Rows shelf?

A. The Filter card
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B. The vertical axis in the view
C. The Marks card
D. The horizontal axis in the view

Answer: D

Explanation: 
 In Tableau, when creating a combined axis chart, after dragging the first measure to the Rows shelf, you should drag the second measure directly onto the
existing axis in the view. This will combine both measures on the same axis, allowing them to share a scale and an axis, which is the essence of a combined axis
chart.

NEW QUESTION 96
Which of the following are valid use-cases for the 'Manage Metadata' functionality?

A. To clean and automatically fix the data issues in our data source
B. To see the field name in the original data source
C. To view all hidden fields
D. To see the table a field belongs to

Answer: BCD

Explanation: 
 Top of Form
To clean and automatically fix the data issues in our data source - This is the definition of Data Interpreter.
To rename the field in the original data source - We never modify the original data source when managing metadata. All changes are local to Tableau for our
convenience only.
All other options can be modified using the Manage Metadata property.

NEW QUESTION 98
Which of the following are valid options to define the scope of a reference line? Choose 3.

A. Pane
B. Table
C. Section
D. Window
E. cell
F. Axis

Answer: ABE

Explanation: 
When we create a reference line, we get the following 3 options for the scope:
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Reference: https://help.tableau.com/current/pro/desktop/en-us/reference_lines.htm

NEW QUESTION 99
Which two analytics options are available for a scatter plot view? Choose two.

A. Forecast
B. Totals IS
C. Reference lines
D. Trend lines

Answer: CD

Explanation: 
For a scatter plot view in Tableau, you can add reference lines and trend lines as part of the analytics options. Reference lines can be added to a visualization to
mark certain values or to provide context, such as an average line across a scatter plot. Trend lines, on the other hand, are used to show the relationship between
two variables in the view, indicating the general direction or pattern of the data points in a scatter plot.

NEW QUESTION 100
What should you use to create headers in a visualization?

A. A parameter
B. A measure
C. A dimension
D. A filter

Answer: C

Explanation: 
 According to the Tableau Help, headers are “labels that identify the different parts of your view”. The help also states that “Headers are created when you place a
discrete dimension on Columns or Rows” (page 1).

NEW QUESTION 101
You have a continuous numeric measure named Sales.
Which chart type is created when you double-click the Sales measure?

A. A text table
B. A line chart
C. A pie chart
D. A bar chart

Answer: B

Explanation: 
 When you double-click a continuous numeric measure named Sales in Tableau, it automatically creates a bar chart. Tableau's default behavior for a single
measure is to display it as a bar chart, with the measure values represented on the Y-axis and an automatic range on the X-axis.

NEW QUESTION 106
True or False: Tableau can create worksheet-specific filters

A. True
B. False

Answer: A

Explanation: 
 Yes, it is possible to create worksheet-specific filters in Tableau.
When you add a filter to a worksheet, by default it applies to the current worksheet. Sometimes, however, you might want to apply the filter to other worksheets in
the workbook.
Then, you can select specific worksheets to apply the filter to or apply it globally to all worksheets that use the same data source or related data sources.
Reference: https://help.tableau.com/current/pro/desktop/en-us/filtering_global.htm
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NEW QUESTION 108
The option to create bins is available for which type of field?

A. Boolean
B. String
C. Date
D. Numeric

Answer: D

Explanation: 
 The option to create bins in Tableau is available for numeric fields. Bins allow you to group a series of numeric values into larger segments, which can simplify
analysis and help in creating histograms or other visualizations that show the distribution of data. For example, you can create bins to group ages into categories
like 0-10, 11-20, etc.

NEW QUESTION 109
Which statement accurately describes a join?

A. Away to combine multiple Tableau workbooks using similar data sources
B. A combination of rows appended from different tables that have the same column names
C. Away to combine table columns in relational databases by using shared values
D. A combination of columns appended from different tables that have similar values

Answer: C

Explanation: 
 According to the [Tableau Desktop Specialist Exam Guide], a join is a way to combine table columns in relational databases by using shared values. A join can be
inner, left, right, or full, depending on how the matching rows are included or excluded.

NEW QUESTION 112
What are three options to change the scope of a reference line? Choose three.

A. Per Pane
B. Fill Above
C. Entire Table
D. Maximum
E. Per Cell

Answer: ACE

Explanation: 
 You can change the scope of a reference line by choosing one of the following options: Per Pane, Entire Table, or Per Cell. The scope determines how many
reference lines are added to the view and how they are calculated. Per Pane adds one reference line for each pane in the view. Entire Table adds one reference
line for the entire table in the view. Per Cell adds one reference line for each cell in the view

NEW QUESTION 117
Is it possible to add both a Dashboard and a Worksheet at the same time to a Story Point in Tableau?

A. Yes
B. No

Answer: B

Explanation: 
This is a tricky question. We are talking about story POINTS, and not entire stories in the question.
To create a story, lets say I have a blank story with 1 dashboard and 1 worksheet. I can simply drag the dashboard into the view to create a new story point.

Now, if I try to adjust the worksheet beside it in this same view, I cannot. See below:
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The only option available is to replace the existing view. Therefore, the answer is NO since
they both cannot be added.
Read more about stories in Tableau: https://help.tableau.com/current/pro/desktop/en- us/story_create.htm

NEW QUESTION 119
_____ is a snapshot of the data that Tableau stores locally. Good for very large datasets of which we only need few fields.

A. Tableau Packaged Workbook (.twbx)
B. Tableau Workbook (.twb)
C. Tableau Data Extract (.tde)
D. Tableau Data Source (.tds)

Answer: C

Explanation: 
 Tableau Data Extract (TDE) is a snapshot of the data that Tableau stores locally. Good for very large datasets of which we only need few fields. Performance is
optimised because it queries its own database engine instead of the local data source.
When you create an extract of your data, you can reduce the total amount of data by using filters and configuring other limits. After you create an extract, you can
refresh it with data from the original data. When refreshing the data, you have the option to either do a full refresh, which replaces all of the contents in the extract,
or you can do an incremental refresh, which only adds rows that are new since the previous refresh.
Extracts are advantageous for several reasons:
1) Supports large data sets: You can create extracts that contain billions of rows of data.
2) Fast to create: If you're working with large data sets, creating and working with extracts can be faster than working with the original data.
3) Help improve performance: When you interact with views that use extract data sources, you generally experience better performance than when interacting with
views based on connections to the original data.
4) Support additional functionality: Extracts allow you to take advantage of Tableau functionality that's not available or supported by the original data, such as the
ability to compute Count Distinct.
5) Provide offline access to your data: Extracts allow you to save and work with the data locally when the original data is not available. For example, when you are
traveling.

NEW QUESTION 120
Which of the following describes the best way to change the formatting at a workbook
level?

A. Right click anywhere in the view, choose format, and then specify the formatting in the new Format workbook pane.
B. It is only possible to specify formatting at a worksheet level, not at the workbook level.
C. Click on Text in the Marks card, choose format, and then specify the formatting in the new Format workbook pane.
D. Choose Format from the menu on top and then specify the formatting in the new Format workbook pane.

Answer: D

Explanation: 
It is very much possible to specify the formatting at a WORKBOOK level (all sheets) instead of a single worksheet level.
You can quickly change how fonts, titles, and lines look in every view in a workbook by specifying format settings at the workbook level, instead of the worksheet
level.
For example, you might want to use a specific font, size, and color so that all views adhere to your company's brand. You might also want to remove grid lines from
your views—or make them more noticeable by increasing their pixel size or color.
You can also change the theme used by your workbook. Themes control items like the default font, colors, and line thickness. When you create a new workbook, it
automatically uses the Default theme, which uses visual best practices.
Change fonts in your workbook:
You can change all fonts in your workbook or you can change fonts for only certain areas, such as just worksheet titles.
1) On the Format menu, select Workbook.
2) The Format Workbook pane replaces the Data pane on the left and provides a series of drop-down lists where you can change all font settings in a workbook,
as well as the font settings for titles of worksheets, stories, and dashboards.
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Note: If you have made font changes at the worksheet level, such as on a filter card or a worksheet title, changing the font at the WORKBOOK level will overwrite
those changes.

Reset a workbook to its default settings
When you make changes to your workbook's font settings, a gray dot appears next to the setting in the Format Workbook pane. You can quickly switch back to
default settings using the Reset to Defaults button.
1) On the Format menu, select Workbook.
2) In the Format Workbook pane, click Reset to Defaults.
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Reference: https://help.tableau.com/current/pro/desktop/en-us/formatting_workbook.htm

NEW QUESTION 121
Which two elements can have their values changed by using a dashboard action? Choose two.

A. Bins
B. Groups
C. Sets
D. Parameters

Answer: CD

Explanation: 
 In Tableau, the two elements that can have their values changed by using a dashboard action are Sets and Parameters. Dashboard actions can be configured to
modify the values within a set or a parameter, allowing for interactive and dynamic changes in the visualization based on user interactions. For example, selecting
a specific data point in a dashboard can trigger an action that updates a set or changes the value of a parameter, which in turn can alter the displayed data or the
appearance of visualizations within the dashboard.

NEW QUESTION 124
Which of the following is an example of a Date Part?

A. Q4 2017
B. March 2019
C. September 2020
D. November

Answer: D

Explanation: 
All answers except November are examples of Date Values (continuous in nature).
See below:
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You can see that the option in Green symbolizes our correct answer, i.e only a Month. In our case that month is November (the correct answer).
All other options are combinations of a year with one other value (like a month, quarter, or day). So this is how by looking at an option you can know if its a date
part or date value!

NEW QUESTION 127
Which two functionalities can you provide to consumers by adding a parameter to a visualization? Choose two.

A. Change fields in the visualization.
B. Download the underlying data as a CSV file.
C. Change the results of calculations in the visualization.
D. Create a new field in the data source.

Answer: AC

Explanation: 
 In Tableau, parameters are dynamic values that can replace a constant in calculations, filters, and reference lines. If you have a parameter controlling a
calculation, changing the parameter value can change the results of that calculation, thus impacting the visualization. Parameters can also be used to switch
between different fields in the visualization; for example, allowing users to choose which measure or dimension to display.

NEW QUESTION 132
For a ______ sort, no matter how the data changes, the values will always stay in the sort order we kept stuff in.

A. Random
B. Manual
C. Topological
D. Hierarchical

Answer: B

Explanation: 
 For a manual sort, no matter how the data changes, the values will always stay in the sort order you kept stuff in.
From the official website:
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Reference: https://help.tableau.com/current/reader/desktop/en-us/reader_sort.htm

NEW QUESTION 135
When using Animations in a Tableau, which of the following is the default duration for animations?

A. 0.4s
B. 0.3s
C. 0.5s
D. 0.2s

Answer: B

Explanation: 
The LATEST Tableau Desktop Sepcialist exam blueprint now requires you to know some basics about animations as well!
NOTE: Animations are DISABLED by default and must be manually enabled.

You can also reset all settings to default by clickin on 'Reset All'
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Reference: https://help.tableau.com/current/pro/desktop/en-us/formatting_animations.htm

NEW QUESTION 137
Are animations enabled by default in Tableau?

A. No
B. Yes

Answer: A

Explanation: 
No, by default, animations are not enabled in Tableau.
We can animate visualizations to better highlight changing patterns in your data, reveal spikes and outliers, and see how data points cluster and separate.
Animations visually transition between filter, sort, and zoom settings, different pages, and changes to filter, parameter, and set actions. As visualizations animate in
response to these changes, viewers can more clearly see how data differs, helping them make better informed decisions.
When you author animations, you can choose between two different styles: simultaneous or sequential. Here are examples of each type.
1) Simultaneous animations
The default simultaneous animations are faster and work well when showing value changes in simpler charts and dashboards.
2) Sequential animations
Sequential animations take more time but make complex changes clearer by presenting them step-by-step.
To Animate visualizations in a workbook:
1) Choose Format > Animations.
2) If you want to animate every sheet, under Workbook Default, click On. Then do the following:
For Duration, choose a preset, or specify a custom duration of up to 10 seconds.
For Style, choose Simultaneous to play all animations at once or Sequential to fade out marks, move and sort them, and then fade them in.
3) To override workbook defaults for a particular sheet, change the settings under Selected Sheet.
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Reference: https://help.tableau.com/current/pro/desktop/en-us/formatting_animations.htm

NEW QUESTION 141
Which of the following charts types always includes bars sorted in descending order?

A. Pareto Chart
B. Pie Chart
C. Gantt Chart
D. Stacked Bar Chart

Answer: A

Explanation: 
 A Pareto chart is a type of chart that contains both bars and a line graph, where individual values are represented in descending order by bars, and the ascending
cumulative total is represented by the line.
On the primary axis, bars are used to show the raw quantities for each dimension member, sorted in descending order.
On the secondary axis, a line graph is used to show the cumulative total in percent format.

Reference: https://help.tableau.com/current/pro/desktop/en-us/pareto.htm

NEW QUESTION 145
Is it possible to deploy a URL action on a dashboard object to open a Web Page within a dashboard rather than opening the system’s web browser?

A. YES, we can do this with the help of a plugin
B. NO, this is not currently possible in Tableau
C. YES, we can do this with the help of a Web-Page object
D. YES, we can do this with the help of Tableau Public
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Answer: C

Explanation: 
 To interactively display information from the web INSIDE a dashboard, you can use a URL action with a web page object.
For example, you might have a dashboard that shows profits by country. In addition to showing the profit data in your dashboard, you also want to display
supplemental information about the countries from a web site.
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Reference: https://help.tableau.com/current/pro/desktop/en-us/actions_dashboards.htm

NEW QUESTION 147
By default, measures placed in a view are aggregated. The type of aggregation applied _______

A. 
is always sum

B. depends on the context of the view
C. is always COUNT
D. is always AVERAGE

Answer: B

Explanation: 
 By default, measures placed in a view are aggregated. Mostly you'll notice that the aggregation is SUM, but not ALWAYS.
The type of aggregation applied varies depending on the context of the view. Reference: https://help.tableau.com/current/pro/desktop/en-
us/calculations_aggregation.htm

NEW QUESTION 151
You need to display the complete list of potential data connections when you connect to a server. What action should you perform?

A. Select File on the menu, and then select New
B. Select Connecting to Data.
C. Select More under To a Server
D. Select More under To a File.

Answer: C

Explanation: 
 To display the complete list of potential data connections when connecting to a server in Tableau, you should select "More" under the "To a Server" option. This
action will provide a comprehensive list of server types and data sources that Tableau can connect to.

NEW QUESTION 153
True or False: All rows from both tables are returned in an INNER JOIN

A. True
B. False

Answer: B

Explanation: 
 The INNER JOIN keyword selects all rows from both tables as long as there is a match between the columns. Consider 2 tables "Orders" and "Customers".
If there are records in the "Orders" table that do not have matches in "Customers", these orders will not be shown!
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Reference: https://www.w3schools.com/sql/sql_join_inner.asp

NEW QUESTION 158
Which of the following are valid ways of Grouping Data?

A. Using Marks in the view
B. Using Labels in the View
C. From the Analytics Pane
D. From the Dimensions Shelf

Answer: ABD

Explanation: 
**IMPORTANT QUESTION AND EXPLANATION, PLEASE READ**
3 ways to group data -
1) Marks
2) Labels
3) Dimensions shelf.
*IMPORTANT*
If we Group the data by selecting the marks, then they remain separate marks in the view and then have the same colour. Also, a new group is created in the
Dimensions shelf. Example -
Using the sample superstore dataset, first plot a bar chart showing sales for each sub- category:

Here, if we Select Phones, Chairs and Storage by selecting the MARKS (Bars), and then group them:
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They remain seperate marks (BARS) but are grouped by the same colour. Now, if we didn't do this, and rather grouped by selecting their Labels (Names):

Then they no longer remain separate Marks (bars) but are rather consolidated into a single Bar:

The Leader of IT Certification visit - https://www.certleader.com



100% Valid and Newest Version TDS-C01 Questions & Answers shared by Certleader
https://www.certleader.com/TDS-C01-dumps.html (314 Q&As)

Finally, we can group directly from the Dimensions shelf as follows:

Now choose Phones, Chairs and Storage and Click Group:

You will now automatically have a new Dimension as follows:

Reference: https://help.tableau.com/current/pro/desktop/en- us/sortgroup_groups_creating.htm

NEW QUESTION 162
Dragging a ______ to colour creates distinct colours for each item whereas dragging a _____ to colour creates a gradient

A. Discrete value, Continuous Value
B. Geographic Value, Discrete Value
C. Continuous Value, Discrete Value
D. Longitude, Latitude

Answer: A

Explanation: 
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Remember that dragging a discrete value to colour creates distinct colours for each item whereas dragging a continuous value to colour creates a gradient. ( Same
for Map )
From the official documentation:

Reference: https://help.tableau.com/current/pro/desktop/en-us/viewparts_marks_markproperties_color.htm

NEW QUESTION 164
Beginning in version 10.5, when you create a new extract, it uses the ______ format instead of the .tde format.

A. .tds
B. .tdex
C. .hyper
D. .twbx

Answer: C

Explanation: 
 Beginning in version 10.5, when you create a new extract, it uses the .hyper format instead of the .tde format.
Extracts in the .hyper format take advantage of the improved data engine, which supports the same fast analytical and query performance as the data engine
before it, but for even larger extracts.
Although there are many benefits of using .hyper extracts, the primary benefits include the following:
1) Create larger extracts: You can create extracts with billions of rows of data. Because .hyper extracts can support more data, you can consolidate .tde extracts
that you previously had to create separately into a single .hyper extract.
2) Create and refresh extracts faster: While Tableau has always optimized performance for creating and refreshing extracts, version 2020.3 supports faster extract
creation and refreshes for even larger data sets.
3) Experience better performance when interacting with views that use extract data sources: Although smaller extracts continue to perform efficiently, larger
extracts perform more efficiently.
Reference: https://help.tableau.com/current/pro/desktop/en-us/extracting_upgrade.htm

NEW QUESTION 168
Which of the following would you use to edit the Shape, colour, and Text of your visualisations?

A. Marks Card
B. Data Pane
C. Filter Shelf
D. Analytics Pane

Answer: A

Explanation: 

The Leader of IT Certification visit - https://www.certleader.com



100% Valid and Newest Version TDS-C01 Questions & Answers shared by Certleader
https://www.certleader.com/TDS-C01-dumps.html (314 Q&As)

The Marks Card allows us not only to edit the Shape, Text and Colour, but also to modify the Tooltip and the level of detail of the visualisation!

The Marks card is a key element for visual analysis in Tableau. As you drag fields to different properties in the Marks card, you add context and detail to the marks
in the view.

You use the Marks card to set the mark type (see Change the Type of Mark in the View), and to encode your data with color, size, shape, text, and detail. To
change the mark settings, see Control the Appearance of Marks in the View.

In this example, three different fields have been dragged to different properties in the Marks card. Segment is on Color, Region is on Shape, and Quantity is on
Size.
After you add a field to the Marks card, you can click the icon next to the field to change the
property it is using. You can also click the property buttons in the Marks card to change those settings.
Many properties can have multiple fields. For example, you can add multiple fields to Label, Detail, Tooltip, and Color. Size and Shape can only have one field at a
time. For more details, see Control the Appearance of Marks in the View.
Reference: https://help.tableau.com/current/pro/desktop/en-us/buildmanual_shelves.htm

NEW QUESTION 172
You may create a context filter to:
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A. To create a dependent filter
B. Improve performance
C. To replace a data source filter
D. Create a dependent numerical or top N filter

Answer: BD

Explanation: 
 Important question! You cannot use a context filter to replace a data source filter since each filter type has its own use case. Also, a content filter is an
Independent filter and all other filters are called dependent since they only process the data that passes through a context filter.
According to the official documentation :
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Reference: https://help.tableau.com/current/pro/desktop/en-us/filtering_context.htm

NEW QUESTION 177
_____ contains the visualisations, info needed to build the visualisations, and a copy of the data source.

A. Tableau Data Extract (.tde)
B. Tableau Packaged Workbook (.twbx)
C. Tableau Bookmark (.tbm)
D. Tableau Workbook (.twb)

Answer: B

Explanation: 
 TWBX is all in one. It contains viz, info needed to build the viz, and a copy of the data source. It doesn’t contain extracts of the data but can contain both live and
data extracts. Best if want to eliminate the barrier of data access.
Create a .twbx with file-based data sources
1) Select File > Save As.
2) Specify a file name for the packaged workbook in the Save As dialog box.

3) Select Tableau Packaged Workbooks on the Save as type drop-down list.
4) Click Save.
5) The default location is the Workbooks folder of the Tableau repository. However, you can save packaged workbooks to any directory you choose.
The following files are included in packaged workbooks:
--> Background images
--> Custom geocoding
--> Custom shapes
--> Local cube files
--> Microsoft Access files
--> Microsoft Excel files
--> Tableau extract files (.hyper or .tde)
--> Text files (.csv, .txt, etc.)
Reference: https://help.tableau.com/current/pro/desktop/en-us/environ_filesandfolders.htm

NEW QUESTION 180
A dual axis chart is useful for comparing two measures that _____.
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A. have different scales
B. have little in common
C. are Table Calculations
D. are aggregated Dimensions

Answer: A

Explanation: 
 A dual axis chart is useful for comparing two measures that have different scales. A dual axis chart is a type of visualization that shows two measures using two
independent axes layered on top of one another. A dual axis chart allows you to compare and contrast two measures that have different ranges or units of
measurement, such as sales and profit margin, temperature and precipitation, or population and GDP per capita. A dual axis chart can also show different mark
types for each measure, such as bars and lines, circles and areas, or shapes and texts. The other options are not valid reasons for using a dual axis chart for
comparing two measures. Have little in common is not correct, because a dual axis chart is meant to show some kind of relationship or correlation between two
measures, not just contrast them. Are Table Calculations is not correct, because a dual axis chart can be used with any type of measure, whether it is an
aggregation, a calculation, or an expression. Are aggregated Dimensions is not correct, because a dual axis chart cannot be used with dimensions, only with
measures. Dimensions are fields that contain qualitative values that are used to categorize or segment data, not compare them.

NEW QUESTION 181
What do the colours Blue and Green represent in Tableau?

A. Discrete and Continuous
B. Measures and Dimensions
C. Continuous and Discrete
D. Dimensions and Measures

Answer: A

Explanation: 
Important question! If you selected Dimension and Measure, don't worry! It is a very common mistake. But we're here to learn aren't we?
When you connect to a new data source, Tableau assigns each field in the data source as dimension or measure in the Data pane, depending on the type of data
the field contains. You use these fields to build views of your data.
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Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_typesandroles.htm

NEW QUESTION 185
Which of the following are valid ways to italicize Tooltip content in Tableau?

A. Click on Format in the Menu bar, choose Font, and then edit the Tooltip options to italicize the font
B. Click on Tooltip in the Marks card, select the text, and then use the Italics option
C. Click on Worksheet in the Menu bar, select Tooltip, and then use the italics option
D. Click on Dashboard in the Menu bar, select Tooltip, and then use the italics option

Answer: ABC

Explanation: 
The only incorrect option is - Click on Dashboard in the Menu bar, select Tooltip, and then use the italics option.
This option doesn't exist. See below:
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The rest of the options do exist, and therefore are correct:
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NEW QUESTION 188
How can you add color to marks in the view in Tableau?

A. Click on Data in the main menu above, and click on choose color.
B. From the Data pane, drag a field to Color on the Marks card.
C. In the column/row shelf, right click the field and click on edit in shelf to select the color.
D. From the Analytics pane, drag a model to Color on the Marks card.

Answer: B

Explanation: 
To assign a color to marks in the view, do the following: From the Data pane, drag a field to Color on the Marks card.
Tableau applies different colors to marks based on the field’s values and members. For example, if you drop a discrete field (a blue field), such as Category, on
Color, the marks in the view are broken out by category, and each category is assigned a color.
If you drop a continuous field, such as SUM(sales), on Color, each mark in the view is colored based on its sales value.

NEW QUESTION 193
You want to provide additional information when hovering over a field in the Data pane as shown in the following exhibit.
What should you configure for the field?

A. An alias
B. A header label
C. A hierarchy
D. A default comment

Answer: D

Explanation: 
 To provide additional information when hovering over a field in the Data
pane, as shown in the exhibit, you need to configure a default comment for the field. This comment can be set by right-clicking on the field in the Data pane and
selecting "Default Properties" and then "Comment." The text entered as a comment here will then be displayed as a tooltip when hovering over the field in the Data
pane.

NEW QUESTION 194
Which of the following are required to create a trend line?

A. 2 measures on opposing axes, or a date and a measure on opposing axes.
B. 1 measure, or a date and a dimension on opposing axes.
C. 1 measure only
D. 2 dimensions, or a date and a dimension on opposing axes.

Answer: A

Explanation: 
 To create a trend line, we need:
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Reference: https://help.tableau.com/current/pro/desktop/en-us/trendlines_add.htm

NEW QUESTION 198
Which chart type uses automatically generated sizes that cannot be resized by using the Marks card?

A. Treemaps
B. Pie charts
C. Histograms
D. Area charts

Answer: A

Explanation: 
 Treemaps use automatically generated sizes that cannot be resized by using the Marks card. A treemap is a type of visualization that shows hierarchical data as a
set of nested rectangles. Each rectangle represents a dimension member and its size is proportional to a measure value. Tableau automatically calculates the size
of each rectangle based on an optimal aspect ratio for readability and comparison. You cannot manually adjust the size of each rectangle by using the Marks card
or any other option in Tableau10 The other chart types do not use automatically generated sizes that cannot be resized by using the Marks card. Pie charts use
angles to show proportions of a whole, not sizes. Histograms use bins and frequencies to show distributions of a measure, not sizes. Area charts use filled areas to
show trends over time or categories, not sizes. You can adjust the size of these chart types by using the Marks card or other options in Tableau

NEW QUESTION 200
When using the manage metadata option, we can create custom names for columns where _____ is the original name of the column whereas ______ is the
custom name we created in Tableau.

A. Remote Field Name, Field Name
B. Local Name, Actual Name
C. Column Name, Actual Name
D. Local Field, Global Field

Answer: A

Explanation: 
Using the Sample superstore as a reference, click on the manage metadata icon as follows:

We can rename a particular column name to make it easier to remember and use in Tableau. Let's change Order ID to oID as shown:
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Now, we'll see oID when using this data source in Tableau. This WILL NOT affect the original data source. The remote field name let's us see what the name of the
column is in the ORIGINAL Data source.
Reference: https://help.tableau.com/current/pro/desktop/en- us/environment_datasource_page.htm#Metadata

NEW QUESTION 203
Which two filter modes can you use with continuous filters? Choose two.

A. Multiple Values
B. Special
C. Range of Values
D. Single Values

Answer: BC

Explanation: 
 According to the Tableau Help, there are two filter modes for continuous filters: Range of Values and Single Value. The help also states that “Range of Values lets
you specify a minimum and maximum value for the filter using sliders or input fields” and “Single Value lets you select one value on a slider for the filter” (page 1).

NEW QUESTION 204
What are two use cases for a story? Choose two.

A. Provide additional editing and interactive capabilities to your audience.
B. Present a data narrative to lead your audience to your conclusions.
C. Assemble a sequenced analysis to share with collaborators.
D. To allow for easier exporting to Power Point.

Answer: BC

Explanation: 
 You can use a story to present a data narrative to lead your audience to your conclusions, or to assemble a sequenced analysis to share with collaborators. A
story is a sequence of visualizations that work together to convey information. You can create stories to tell a data story, provide context, demonstrate how
decisions relate to outcomes, or to simply make a compelling case4

NEW QUESTION 209
True or False: You get different filtering options for categorical and quantitative data

A. True
B. False

Answer: A

Explanation: 
Yes! We get different options for filtering depending on whether we use a categorical data (think dimension) or quantitative data (think measure).
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Important Note: Each tab adds additional definitions to your filter. For example, you can select to exclude values under the General tab, and also add limits under
the Top tab. Selections and configurations from both tabs are applied to your filter.At any time, you can see the definitions of your filter under Summary on the
General tab.

Note: If you have a large data source, filtering measures can lead to a significant degradation in performance. It is sometimes much more efficient to filter by
creating a set containing the measure and then apply a filter to the set. For more information about creating sets, see Create Sets
Reference: https://help.tableau.com/current/pro/desktop/en-us/filtering.htm

NEW QUESTION 210
Using the Time Series Table, create a Line chart showing the Monthly Year over Year Growth for the Sales, broken down by Assortment. For the Electronics
assortment, which Month had the most NEGATIVE value of Year over Year Growth?

A. October
B. September
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C. July
D. June

Answer: A

Explanation: 

Follow along:
1) Drag Assortment and Year ID (choose Discrete Month) to Columns shelf, and Sales to the Columns Shelf.
For sales, click on the pill -> choose Quick Table calculation -> Year over Year growth.
The view should now look like:

NEW QUESTION 214
What are two methods for renaming a field in a visualization? Choose two.

A. From the Data pane, click and hold on the field until the name is editable.
B. From the Data pane, use the field's drop-down menu and select Rename.
C. From the Format menu, select Field Labels.
D. From the Data pane, right-click the field and select Replace References.

Answer: AB

Explanation: 
 In Tableau, you can rename a field directly in the Data pane by clicking and holding on the field name until it becomes editable, allowing you to type a new name.
Alternatively, you can use the drop-down menu associated with the field in the Data pane and select the "Rename" option. Both methods provide a quick and easy
way to change the name of a field without affecting the underlying data structure. The "Format menu" and "Replace References" option do not apply to renaming
fields.

NEW QUESTION 218
You need to uniformly change the size for all marks in a view. What should you do?

A. Select Label on the Marks card and then select Alignment.
B. Use the Fit dropdown menu on the toolbar.
C. Select Format on the menu, and then select Cell Size.
D. Select Size on the Marks card and use the slider to adjust the size

Answer: D

Explanation: 
 You should select Size on the Marks card and use the slider to adjust the size to uniformly change the size for all marks in a view. The Size property on the Marks
card allows you to control the size of marks in the view by moving the slider to the left or right. The Size slider affects different marks in different ways, such as
making them bigger or smaller, wider or narrower, or thicker or thinner1 The other options are not valid ways to uniformly change the size for all marks in a view.
Selecting Label on the Marks card and then selecting Alignment will allow you to change the position of labels on marks, not the size of marks2 Using the Fit
dropdown menu on the toolbar will allow you to change how the view fits within the worksheet, not the size of marks3 Selecting Format on the menu, and then
selecting Cell Size will allow you to change the height and width of cells in a text table, not the size of marks in other types of views4

NEW QUESTION 219
Skipped Join the Geo Data and Time Series Table on the Item Number ID column, and display the Store count for every State on a Map. What was the Store
count in 2017 for Texas (TX)?
Join the Geo Data and Time Series Table on the Item Number ID column, and display the Store count for every State on a Map. What was the Store count in 2017
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for Texas (TX)?

A. 592,593
B. 293,202
C. 416,702
D. 336,908

Answer: C

Explanation: 
 Since you need BOTH State and the YEAR, we need to use an Inner Join. Follow the steps below:

NEW QUESTION 221
We can use ______ as a static tool to open and interact with packaged workbooks with extracted data sources that have been created in Tableau Desktop.

A. Tableau Reader
B. Tableau Online
C. Tableau Server
D. Tableau Desktop

Answer: A

Explanation: 
 The word 'static tool' gives it away.
According to the official website :

Reference: https://help.tableau.com/current/reader/desktop/en-us/reader_welcome.htm

NEW QUESTION 224
You have a bar chart that has a dimension on the Columns shelf and a measure on the Rows shelf.
How can you make a stacked bar chart?

A. Drag another dimension to Color on the Marks card
B. Drag another measure to Color on the Marks card.
C. Drag another dimension to Size on the Marks card.
D. Drag another measure to the left of the measure on the Rows shelf.

Answer: A

Explanation: 
 To create a stacked bar chart in Tableau, you can drag a second dimension to the Color shelf on the Marks card. This action will segment the bars already
present in the chart by the new dimension, stacking the segments on top of each other within each
bar. This is a common method to add additional layers of detail to a bar chart and effectively compare parts to a whole across categories.

NEW QUESTION 228
______ refers to the level of detail for a piece of data, wherever you are looking.

A. Data Cleanliness
B. Data granularity
C. Data connectivity
D. Data LOD

Answer: B
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Explanation: 
 Data is generated and analyzed at many different levels of granularity. Granularity is the level of detail of the data. For example, when looking at graduation data,
granularity would describe whether a row in the data set represents a single person or the graduating class of a university.
Reference: https://www.tableau.com/about/blog/2018/6/data-prep-101-what-aggregate-function-and-how-do-you-combine-aggregated-data-89244

NEW QUESTION 229
How can you format an axis as Bold in Tableau?

A. By choosing the axis and selecting Command/Control + B on your keyboard
B. By right clicking on the axis, choosing Edit Axis, and then setting its font to bold.
C. By right clicking on the axis, choosing format, and then setting its font to bold.
D. By clicking on Format on the main menu bar, choosing field labels, and setting it to bold.

Answer: C

Explanation: 
To make an axis bold, simply right click it, select format, and then click on Font to choose Bold:

None of the other options are valid ways to make the axis bold.

Read more about editing axis: https://help.tableau.com/current/pro/desktop/en- us/formatting_editaxes.htm

NEW QUESTION 232
You want to save a view as an image that you can paste into a Microsoft Word document. Which two statements accurately describe exporting a view as an
image? Choose two.
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A. Default exports include everything in the view, including Tableau fonts.
B. The default export format is TIFF.
C. The default export format is PNG.
D. The exported image is a vector-based file that embeds the Tableau fonts.

Answer: AD

Explanation: 
 When exporting a view as an image in Tableau, the default export includes everything that is currently displayed in the view, with Tableau applying its own styling,
including fonts. The default format for an exported image is PNG, which is a raster-based file format that captures all visual elements as pixels. PNG is widely used
for its lossless compression and is suitable for detailed images like those produced by Tableau. Unlike vector-based images, PNGs do not embed fonts, and the
image quality remains consistent when the image is viewed on different platforms, which makes it ideal for inserting into documents like Microsoft Word.

NEW QUESTION 235
How can you format numbers in Tableau as currency?

A. Right-click a measure or axis in the view and select Forma
B. Then in the Format pane, click the Numbers drop-down menu.
C. Right-click on the data source used in the view and select Forma
D. Then in the Format pane, click the Numbers drop-down menu.
E. Right-click a dimension in the view and select Forma
F. Then in the Format pane, click the Numbers drop-down menu.
G. Right-click on the Sheet name and select Forma
H. Then in the Format pane, click the Numbers drop-down menu.

Answer: A

Explanation: 
According to the official Tableau documentation:

Reference: https://help.tableau.com/current/pro/desktop/en- us/formatting_specific_numbers.htm

NEW QUESTION 236
Which of the following are valid Dashboard size options?

A. Range
B. Fixed Size
C. Automatic
D. Scaled

Answer: ABC

Explanation: 
Scaled is NOT a valid size options when creating Dashboards in Tableau!
After you create a dashboard, you might need to resize and reorganize it to work better for your users.
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Reference: https://help.tableau.com/current/pro/desktop/en- us/dashboards_organize_floatingandtiled.htm

NEW QUESTION 237
______ is a method for appending values (rows) to tables. You can use this method if both tables have the same columns. The result is a virtual table that has the
same columns but extends vertically by adding rows of data.

A. Joining
B. Blending
C. Combining
D. Unioning

Answer: D
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Explanation: 
Unioning is the correct answer! From the official documentation:

For example, suppose you have the following customer purchase information stored in three tables, separated by month. The table names are "May2016" ,
"June2016" and "July2016."

Reference: https://help.tableau.com/current/pro/desktop/en-us/union.htm

NEW QUESTION 239
Which of the following 2 columns CANNOT be deleted in Tableau?

A. Measure Names
B. Number of Records
C. Measure Values
D. Calculated Fields

Answer: AC

Explanation: 
 Measure names and values CANNOT be deleted in Tableau like other columns can. These are auto-generated.
Calculated Fields, and Number of records can both be deleted.

NEW QUESTION 240
With the Marks card drop-down menu set to Automatic, a line chart will be created whenever you place what on the Rows shelf and the Columns shelf?

A. Measures on one shelf, and a date dimension on the other
B. Zero or more dimensions on one shelf, and 2 or more measures on the other
C. A date dimension followed by a continuous measure on one shelf
D. Zero or more measures on one shelf, and 2 or more dimensions on the other

Answer: A

Explanation: 
 According to the Tableau Desktop Specialist Exam Readiness, a line chart
will be created whenever you place measures on one shelf, and a date dimension on the other. This is because Tableau automatically recognizes date fields and
treats them as continuous dimensions.

NEW QUESTION 243
True or False: Trend lines can only be used with numeric or date fields

A. True

The Leader of IT Certification visit - https://www.certleader.com



100% Valid and Newest Version TDS-C01 Questions & Answers shared by Certleader
https://www.certleader.com/TDS-C01-dumps.html (314 Q&As)

B. False

Answer: A

Explanation: 
 You can show trend lines in a visualization to highlight trends in your data.
To add trend lines to a view, both axes must contain a field that can be interpreted as a number. For example, you cannot add a trend line to a view that has the
Product Category dimension, which contains strings, on the Columns shelf and the Profit measure on the Rows shelf.
However, you can add a trend line to a view of sales over time because both sales and time can be interpreted as numeric values.
Reference: https://help.tableau.com/current/pro/desktop/en-us/trendlines_add.htm

NEW QUESTION 247
What allows you to drill up or down in the level of detail (LOD)?

A. Bins
B. Groups
C. Hierarchies
D. Sets

Answer: C

Explanation: 
 Hierarchies in Tableau allow users to drill up and down to explore data at different levels of detail. By setting up a hierarchy, users can navigate through levels of
the hierarchy to analyze data at each level, from the highest summary down to the finest detail.

NEW QUESTION 248
Dimensions containing ________ and ________ values cannot be continuous.

A. Boolean
B. Date
C. Date and Time
D. String

Answer: AD

Explanation: 
 According to Tableau's official documentation -

Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_typesandroles.htm

NEW QUESTION 253
Given a map, which of the following fields can be placed in Size,Shape,Detail,Color

A. Profit, State, Number of Records, Sales
B. Region, Country, Profit, State
C. Longitude, Country, State, Sales
D. Sales, State, Country, Profit

The Leader of IT Certification visit - https://www.certleader.com



100% Valid and Newest Version TDS-C01 Questions & Answers shared by Certleader
https://www.certleader.com/TDS-C01-dumps.html (314 Q&As)

Answer: D

Explanation: 
 Since Sales is a measure, it can easily be depicted via size.
To drill down and change the level of detail, Country is the correct choice since it will contain STATE. We can then depict the various states by different shapes
such as circle, square etc.
Finally, the Profit can be depicted via a color! Eg - Red for poor and green for excellent profits!
Reference: https://www.tableau.com/learn/tutorials/on-demand/aggregation-granularity- and-ratio-calculations

NEW QUESTION 257
To customize links based on the data in your dashboard, you can automatically enter field values as _______ in URLs

A. parameters
B. sets
C. values
D. inputs

Answer: A

Explanation: 
 A URL action is a hyperlink that points to a web page, file, or other web- based resource outside of Tableau. You can use URL actions to create an email or link to
additional information about your data. To customize links based on your data, you can automatically enter field values as parameters in URLs.
Read more in depth at : https://help.tableau.com/current/pro/desktop/en-us/actions_url.htm

NEW QUESTION 262
When creating a dashboard for multiple devices, which of the following Device options are available in the Device Preview section?

A. Monitor, Default, Phone, Tablet
B. Phone, Tablet, Laptop, Desktop
C. Default, Phone, Tablet, Desktop
D. Phone, Monitor, Laptop, Default

Answer: C

Explanation: 
The following options are available in the Device preview section when creating a Dashboard:

Reference: https://help.tableau.com/current/pro/desktop/en-us/dashboards_dsd_create.htm

NEW QUESTION 266
From which three locations can you sort a visualization? Choose three.

A. The Worksheet menu
B. Tooltip on the Marks card
C. DCA header
D. The Analysis menu
E. An axis
F. Afield label

Answer: AEF

Explanation: 
 According to the Tableau Desktop Specialist Exam Guide, one of the exam objectives is to “Sort data in a visualization”. The guide also states that “You can sort
data in a visualization from three locations: the Worksheet menu, an axis, or a field label” (page
15).

NEW QUESTION 268
You have the following visualization.
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Where should you place a field named Region to show multiple distinct lines on the same axis?

A. Path on the Marks card
B. Color on the Marks card
C. The Columns shelf
D. The Rows shelf

Answer: B

Explanation: 
 To display multiple distinct lines on the same axis based on a field, you should place the field on the Color shelf in the Marks card. This will encode each distinct
value in the Region field with a different color, resulting in separate lines for each region on the same axis.

NEW QUESTION 271
What is a story point in Tableau?

A. A single worksheet or dashboard
B. A collection of dashboards
C. A collection of both worksheets and dashboards
D. A collection of worksheets

Answer: A

Explanation: 
In Tableau, a story is a sequence of visualizations that work together to convey information. You can create stories to tell a data narrative, provide context,
demonstrate how decisions relate to outcomes, or to simply make a compelling case.
A story is a sheet, so the methods you use to create, name, and manage worksheets and dashboards also apply to stories (for more details, see Workbooks and
Sheets). At the same time, a story is also a collection of sheets, arranged in a sequence. Each individual sheet (worksheet or dashboard) in a story is called a story
point.
When you share a story —for example, by publishing a workbook to Tableau Public, Tableau Server, or Tableau Online—users can interact with the story to reveal
new findings or ask new questions of the data.
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Reference: https://help.tableau.com/current/pro/desktop/en-us/stories.htm

NEW QUESTION 274
For creating variable sized bins we use ______

A. Calculated Fields
B. Table Calculations
C. Sets
D. Groups

Answer: A

Explanation: 
 One way to view a measure in Tableau Desktop is to split it into bins. You can think of bins as buckets based on a range of values. For example, say you have a
measure that represents age. Instead of aggregating the measure to calculate the average age, you can bin the measure to define age groups: 0–5, 6–10, 11–15,
and so on. Then you can count the number of people in each age group.
Create a calculated field for variable bin size Step 1
Select Analysis > Create Calculated Field. Step 2
In the Calculated Field dialog box, complete the following steps:

Reference: https://riti-ritesh.blogspot.com/2016/07/creating-variable-sized-bins_8.html

NEW QUESTION 277
DOWNLOAD THE DATASET FROM - https://drive.google.com/file/d/1F8L_Rl5B9LAz8RDi- DdjWx3Iv-SgzaBq/view?usp=sharing ( if you haven't already from the
test instructions page! )
How many different countries are present in the dataset?

A. 150
B. 147
C. 140
D. 156

Answer: B

Explanation: 
Explanation
To reach the correct answer, follow these steps:
1) You can simply drag Country to the view, and look at the marks in the bottom left of Tableau Desktop - 147 marks!
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2) Or, you can simply go to Data Source -> Country Tab -> Describe

As you can see, 147 members exist in this Country column!

NEW QUESTION 280
You can ______ your data to combine two or more tables by appending values (rows) from one table to another

A. join
B. blend
C. concatenate
D. union

Answer: D

Explanation: 
 You can union your data to combine two or more tables by appending values (rows) from one table to another. To union your data in Tableau data source, the
tables must come from the same connection.
For example, suppose you have the following customer purchase information stored in three tables, separated by month. The table names are "May2016,"
"June2016," and "July2016."
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A union of these tables creates the following single table that contains all rows from all tables.

Reference: https://help.tableau.com/current/pro/desktop/en-us/union.htm

NEW QUESTION 285
True or False: A LEFT JOIN or INNER JOIN creates a row each time the join criteria is satisfied, which can result in duplicate rows. One way to avoid this is to use
data blending instead.

A. True
B. False

Answer: A

Explanation: 
Joins combine tables by adding more columns of data across similar row structures. This can cause data loss or duplication if tables are at different levels of detail,
and joined data sources must be fixed before analysis can begin.

Inner join

Left Join
Blends, unlike relationships or joins, never truly combine the data. Instead, blends query each data source independently, the results are aggregated to the
appropriate level, then the results are presented visually together in the view.
Reference: https://help.tableau.com/current/pro/desktop/en-us/multiple_connections.htm

NEW QUESTION 287
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Which of the following is NOT a valid official data source in Tableau Desktop?

A. PostgreSQL
B. SAP HANA
C. Google Firebase
D. Amazon Redshift

Answer: C

Explanation: 
Presently, there is no official way to connect your data inFirebase directly withTableau Desktop.
A workaround however can be to export your Firebase data into Google BigQuery, and then connect it to Tableau Desktop.
But then again, it is a workaround and not an official out-of-the-box solution. The following are the available Data sources available as of now:
1) Server

2) File

NEW QUESTION 291
We can join a maximum of _____ tables in Tableau

A. 16
B. 32
C. 64
D. 128

Answer: B

Explanation: 
 It is possible to join a maximum of 32 tables in Tableau!
Reference: https://www.mytectra.com/interview-question/tableau-interview-question-and- answers

NEW QUESTION 293
A Tableau Data Source File (.tds) contains which of the following?
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A. Default Field Properties
B. Copy of any local file-based data
C. Calculated Fields
D. Data Source Type

Answer: ACD

Explanation: 
 All are correct, except - Copy of any local file-based data. This is contained in a .tdsx file (Tableau Packaged Data Source)!
According to the official documentation -

Reference: https://help.tableau.com/current/pro/desktop/en-us/export_connection.htm

NEW QUESTION 295
You want to add Custom shapes to your visualisation. Where can you add these new shapes?

A. In Downloads -> My Tableau Repository -> Shapes
B. In My Computer -> C: -> Tableau -> Shapes
C. In Program Files -> Tableau -> Shapes
D. In My Documents -> My Tableau Repository -> Shapes

Answer: D

Explanation: 
Here's how to add image files to your repository:
1) Find image file on the internet. I try to find consistent image formats if I plan to use a set of shapes such as logos or flags.
2) Download the image to your computer.
3) Drag images into your My Documents -> My Tableau repository -> Shapes folder.
4) Open Tableau and your new shapes will automatically be included in your "edit shapes" menu.
Reference: https://www.tableau.com/about/blog/2016/2/how-use-custom-shapes-filters- your-dashboard-50200

NEW QUESTION 297
Tableau will automatically create a hierarchy for which two kinds of data? Choose two.

A. Date & Time
B. Date
C. Geographic
D. String

Answer: AD

Explanation: 
 Tableau will automatically create a hierarchy for date and geographic data. A hierarchy is a way of organizing data into different levels of detail. For example, a
date hierarchy can have year, quarter, month, and day levels. A geographic hierarchy can have country, state, city, and zip code levels. Tableau recognizes date
and geographic data based on their data types and formats, and creates hierarchies for them by default. Tableau does not automatically create hierarchies for date
& time or string data3

NEW QUESTION 298
Which of the following are benefits of using Data Extracts in Tableau?

A. Improved Performance
B. Ability to use the data offline
C. Working with freshest data at all times
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D. Faster to work with

Answer: ABD

Explanation: 
 Extracts are advantageous for several reasons:
1) Supports large data sets: You can create extracts that contain billions of rows of data.
2) Fast to create: If you're working with large data sets, creating and working with extracts can be faster than working with the original data.
3) Help improve performance: When you interact with views that use extract data sources, you generally experience better performance than when interacting with
views based on connections to the original data.
4) Support additional functionality: Extracts allow you to take advantage of Tableau functionality that's not available or supported by the original data, such as the
ability to compute Count Distinct.
5) Provide offline access to your data: Extracts allow you to save and work with the data locally when the original data is not available. For example, when you are
traveling.
To work with the MOST up-do-date data, use a live connection instead! Reference: https://help.tableau.com/current/pro/desktop/en-us/extracting_data.htm

NEW QUESTION 302
The row and column shelves contain ______

A. Pills
B. Grand Totals
C. Filters
D. Parameters

Answer: A

Explanation: 
 We can drag fields from the Data pane to create the structure for your visualizations.
The Columns shelf creates the columns of a table, while the Rows shelf creates the rows of a table. You can place any number of fields on these shelves.
These FIELDS are also referred to as PILLS. See below:

Reference: https://help.tableau.com/current/pro/desktop/en-us/buildmanual_shelves.htm

NEW QUESTION 307
Which three statements accurately describe continuous fields? Choose three.

A. Continuous fields appear as green pills.
B. Continuous fields are numeric.
C. The values in continuous fields are treated as an infinite range.
D. Continuous fields are categorical
E. Only measures can appear as continuous.
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Answer: ABC

Explanation: 
 Continuous fields in Tableau have specific characteristics:
? A. Continuous fields appear as green pills:
? B. Continuous fields are numeric:
? C. The values in continuous fields are treated as an infinite range: Incorrect options:
? D. Continuous fields are categorical: This is incorrect because categorical fields are discrete, not continuous.
? E. Only measures can appear as continuous: This is incorrect because dimensions can also be treated as continuous in certain contexts.
References:
? Tableau's official documentation on continuous and discrete fields: Continuous and Discrete

NEW QUESTION 311
How can you change the Default Aggregation for a measure in Tableau?

A. By changing its properties manually every time we need to use it
B. By right clicking the dimension -> Default properties and choosing Aggregation
C. By right clicking the measure -> Default properties and choosing Aggregation
D. By double clicking on the measure, and then choosing Window -> Default Aggregation

Answer: C

Explanation: 
According to the official Tableau documentation:

Dimensions don't have aggregation properties, and adding properties manually each time defeats the whole DEFAULT aggregation purpose. Window tab doesn't
have any default aggregation option!
Reference: https://help.tableau.com/current/pro/desktop/en-us/datafields_fieldproperties.htm

NEW QUESTION 312
Most viewers scan content starting at the ______ of a page.

A. top left
B. center
C. bottom left
D. bottom right
E. top right

Answer: A

Explanation: 
According to Tableau's official documentation:
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Reference: https://help.tableau.com/current/pro/desktop/en- us/dashboards_best_practices.htm

NEW QUESTION 313
What is a Tableau story point?

A. The pane where you set the size of the story
B. A collection of talking points to drive the story
C. An individual sheet or dashboard in the story
D. A collection of sheets arranged in a sequence

Answer: C

Explanation: 
 A Tableau story point is an individual container in a story that holds a sheet or dashboard. It's like a slide in a presentation, and a story is a sequence of these
points that can be used to convey a data narrative, showing how facts are connected and guiding the audience through a sequence of analysis steps.

NEW QUESTION 316
What are two examples of a date value? Choose two.

A. 2020-05-01
B. December
C. Wednesday
D. January 1.1995

Answer: AD

Explanation: 
 Date values in Tableau represent specific points in time and are typically formatted in a standard date format.
? Option A, "2020-05-01", is a standard date format representing the 1st of May, 2020.
? Option D, "January 1, 1995", is another example of a date value, representing the 1st of January, 1995. Options B ("December") and C ("Wednesday") represent
a month and a day of the week, respectively, but do not specify a particular date.

NEW QUESTION 319
Which aggregation is available without requiring a table calculation or calculated field?

A. Running total
B. Standard deviation
C. Sample covariance
D. Percent of total

Answer: B

Explanation: 
 Standard deviation is an aggregation that is available without requiring a table calculation or calculated field. Standard deviation is a statistical measure that shows
how much variation there is from the average value in a set of data. Standard deviation is one of the predefined aggregations in Tableau that can be applied to any
measure by selecting it from the context menu of the measure or from the drop-down menu on the Marks card6 The other options are not aggregations that are
available without requiring a table calculation or calculated field. Running total, sample covariance, and percent of total are all examples of table calculations,
which are computations that are applied to the values in an entire table or partition of a table. Table calculations can be created by selecting them from the context
menu of a measure or by using functions in a calculated field7

NEW QUESTION 320

The Leader of IT Certification visit - https://www.certleader.com



100% Valid and Newest Version TDS-C01 Questions & Answers shared by Certleader
https://www.certleader.com/TDS-C01-dumps.html (314 Q&As)

What are three geographic roles that you can assign to a field? Choose three.

A. Address
B. Time zone
C. City
D. Country
E. Airport

Answer: CDE

Explanation: 
 According to the Tableau Desktop Specialist Exam Guide, city, country, and airport are three geographic roles that you can assign to a field. Address and time
zone are not geographic roles in Tableau.

NEW QUESTION 323
If you see a Blue field, generally it will add ______ to the view

A. axis
B. both
C. none
D. headers

Answer: D

Explanation: 
Important question!

Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_typesandroles.htm

NEW QUESTION 325
Which of the following calculations DO NOT need a quick table calculation?

A. Variance
B. Rank
C. Moving Average
D. Standard Deviation

Answer: AD

Explanation: 
For Standard Deviation and Variance, we don't need to use quick table calculations, since they are available by default. See below:
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However, as seen in the types of quick table calculations available in Tableau, Rank and Moving Average belong to only this category.

NEW QUESTION 326
Which of these is NOT a type of Quick Filter available in Tableau?

A. Wildcard Match
B. Multiple Values (dropdown)
C. Regex Match
D. Single Value (slider)

Answer: C

Explanation: 
Upon clicking on a filter, we see the following options:

Clearly, Regex Match is not one of these options!
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NEW QUESTION 330
......
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